Implementation of WSN Based Transport Information System through ZIGBEE Protocol

M.Sudhagar¹, J.Gobinath²

Abstract—In the present transportation system, getting information about bus arrival is very difficult now a days due to traffic and some external scenarios. In this paper we can monitor bus and get data from the administrators as well as to the travellers whether the bus is arriving on time, early or late and also this information is displayed on the different wireless displays in the bus station. In our project, once the user (traveller) wants to know about the detail and status of a particular bus, then he can able to get the details by giving the bus number and stopping name on the android application in mobile. It communicate to bus depot and start analyzing then Zigbee transceiver receives the signal that the vehicle has entered the zone in particular route specified, then automatically the unique id of the bus (Vehicle ID) will be read from the board (Zigbee MAC id) which has been attached to every vehicle and collects the distance and nearby stopping name and send to depot.

Index Terms—Embedded technology, LPC2148, PIC16F877A Wireless Sensor Networks, ZIGBEEE module.

1 INTRODUCTION

In the existing system, the transportation module doesn’t provide any information regarding current status of bus, it provides only bus timing. This is overcome in proposed system. In this system information regarding the status of particular bus is retrieved using android application and ZigBee protocol. Here ZigBee protocol plays a vital role which provides node to node communication between the nodes in the transportation module. It provides reliable communication.

Based on the analysis of the shortcomings of traditional technologies, including location technology, communication technology, the advantages of Wireless Sensor Network (WSN) and ZigBee are given first. Then the data requirements of Bus Priority Control System (BPCS) are presented. In the BPCS, the WSN nodes are classified into three types, i.e. intersection node, roadside node and vehicle node. Also the system architecture and operation process are expounded briefly. Finally, through the simulation and application of the test platform, the practicability is proved and some useful conclusions are drawn. The measurement results have shown that the short message service SMS is usable in emergency cases, because we haven’t seen any message loss and almost every message is received within a short time. However, a high capacity is needed if we transmit the short message to every user individually.

Future work will have to take a closer look on provider independent measurements and at the SMS broad cost service. Zigbee and IEEE 802.15.4 are widely used in wireless sensor networks (WSN). Observing that data gathering is a major application of WSNs, present several beacon scheduling algorithms with low convergence latency. A zigbee tree network wissth one coordinator (sink), some routers and some devices. Each routers or end devices and relaying incoming data to the sink.

The aim of this project is to get the running status of particular bus using ZigBee protocol. It is node to node communication processes were bus terminus, bus and bus stop are act as node. The remainder of this paper is structured as follows.

Section [2] Proposed System
Section [3] System Implementation
Section [4] Test bed and Discussion
Section [5] Conclusion

2 PROPOSED SYSTEM

The proposed system can monitor bus traffic inside spacious bus stations and can inform administrators as well as to the travelers whether the bus is arriving on time, early or late. This information is then displayed on the different wireless displays in the bus station. In this project, once the user (traveller) wants to know about the detail and status of a particular bus, then he can able to get the details by giving the bus number and stopping name in the android mobile. The Zigbee
transceiver receives the signal that the vehicle has entered the zone in particular route specified, then automatically the unique id of the bus (Vehicle ID) will be read from the board (Zigbee MAC id) which has been attached to every vehicle and collects the distance and nearby stopping name.

The main purposes of wsn deployment are: 1. To monitor Data from remote sensors of different types (temperature, pressure, motion, vibrations, etc.) with WSN connectivity can be easily collected by central unit for further processing and analysis. 2. To control Actuators (switches, valves, sound emitters, robots, etc.) can be controlled remotely by commands sent over the air. 3. Both to monitor and to control Measurements collected from sensors can be immediately used to control actuators present in the same wireless network.

3. SYSTEM IMPLEMENTATION

The use of embedded technology provides several interesting benefits: availability of an abstraction layer for signal acquisition and control via an operating system, high level programming of the signal processing algorithms, large data storage in solid state disks, commercial-off-the-shelf hardware for serial ports, hardware for interfacing various types of displays, etc. A small data-acquisition and relay board provides sufficient I/O to control the e-nose and acquire the signals. The Single Board Computer (SBC) is based on an Intel-code-compatible processor, allowing code development, debugging and testing to be easily done on a desktop personal computer.

3.1 Hardware Requirements

1. ARM Processor [LPC2148 Philips]
2. PIC Processor [PIC16F877A]
3. Zigbee Module [Xbee Series 5]

3.1.1 ARM Processor

The LPC2148 microcontrollers are based on a 16-bit/32-bit ARM7TDI-S CPU with real-time emulation and embedded outline support, that combine the microcontroller with embedded high-speed flash memory ranging up to 512 kB. A 128-bit wide memory interface and sole accelerator architecture enable 32-bit code execution at the highest clock rate. For critical code size applications, the another 16-bit Thumb mode reduce code by more than 30% with minimum performance penalty. Due to their tiny size and low power consumption, LPC2148 are perfect for applications where miniaturization is a key necessity, such as access control. Serial communications interfaces ranging from a USB Full-speed device, multiple UARTs, SPI to I2C-bus and on-chip SRAM up to 40 kB, build these devices very well suited for communication gateways and soft modems, protocol converters, voice recognition and low end imaging, providing equally large buffer size and high processing power.

3.1.2 PIC Processor

The hardware consists of pic16F877A connected with zigbee representing a Wireless sensor node. The design and implementation of a sensor node utilizes emerging hardware, low cost components and new techniques to achieve high data rate, extremely low power operation. Low power operation is achieved not only through selection of efficient hardware, but also through long duty cycling and by Adaptive power algorithm implementation. One cycle of sleep, wakeup, and run is typically the cost of acquiring a single set of sensor samples. For the majority of the time the node is sleeping. While asleep, the microcontroller must maintain its state, while consuming little power and shutting down or disconnecting all peripherals including the radio. In this project WSN node is designed, choosing the Texas Instruments PIC16F877A microcontroller. The PIC16F877A consumes only 2 microwatts in sleep mode while maintaining RAM. The collection of various features has been integrated to create the highest data rate, lowest power mote to date.

3.1.3 Zigbee Module

ZigBee is the name of a specification for a suite of high level communication protocols using small, low-power digital radios based on the IEEE 802.15.4-2007 standard for wireless personal area networks (WPANs), such as wireless headphones connecting with cell phones via short-range radio. The technology is intended to be simpler and cheaper than other WPANs, such as Bluetooth. ZigBee is targeted at radio-frequency (RF) applications that require a low data rate, long battery life, and secure networking.
Zigbee is a single chip 2.4 GHz Transceiver. Zigbee is used in WSN-PIC16F877A as a transmitter and receiver module. Nordic transceiver has total nine external connectors in which six are connected to the PIC16F877A. The port 5 is used for communications with Zigbee and port 2. The WSN-PIC16F877A base unit can be connected to the ultra sonic sensor unit with the help of pins 1-7. The ultrasonic sensor unit can be powered with the WSN-PIC16F877A. The ports P6.7, P2.5, P1.6, and P2.4 are connected through pins 1,2,3,4 respectively. The below diagram explains the connection of general purpose pins through PIC16F877A. The 9V, 3Vcc and ground pins can be used to power the external circuits connected to the WSN PIC16F877A.

3.2 Software Requirements

1. KEIL IDE µvision V 3.31
2. EMBEDDED C
3. MPLAB IDE V8.20a

3.2.1 KEIL IDE µvision V 3.31

In this case, we will mention about the proceeding to write program by using C Language Program that is Keil-CARM.
is used to interpret commands under Program Text Editor of Keil uVision3. We only mention about the proceeding to configure Option value for connection commands of interpretation program together by using Keil-CARM through Keil uVision3. For more detailed commands and functions usage for writing program by Keil-CARM, user can learn them by self from User’s Manual command of Keil-CARM. We can summarize the proceeding to configure default values of Keil uVision3 for using with Keil-CARM as follows:

1. Open program Keil uVision3 that is a program Text Editor of Keil-CARM, it is used to write C Language Source Code program and the feature of this program.

2. Configure default values to interpret commands of uVision3 and can be used with Program Keil uVision3 and Keil-CARM. Click Project → Components, Environment, Books... and then select default value for Compiler from the title Select ARM Development Tools that has 3 modes; Use Keil-CARM Tools, Use GNU Tools and Use ARM Tools. In this case, we must select “Use Keil ARM Tools”, and then we must configure position of folder to store default values of program Keil ARM.

3. Create new Project File by using command Project → new Project and then configure Folder that we want to save new Project File.

4. Copy File named “Startup.s” that ETT has already provided in CD-ROM and is saved in Example named “Startup.s”, and then to place it in the same position folder of new Project File that we created completely. File “Startup.s” is a file that contains Assembly Language Commands of ARM7 to configure the necessary default value for MCU.

5. Configure Option value of Project File by using command Project → Option for Target ‘Target 1’ and then select Tab of Target to configure value of MCU Target as follows.

6. Output: we must click default values of Create HEX File, configure format of Hex to be HEX-386 and then select

7. Start writing C Language Source Code, click command File → New... and we will get the available are to write Text File.

3.2.2 MPLAB IDE V8.20a

The development process with MPLAB consists of four steps:

1. Program the application code into the target application, using MPLAB as the current debug tool.
2. Debug the application.
3. Modify the source code,
4. Rebuild the project and repeat until the application performs as designed.

4. Result and Discussions

The zigbee family from Nordic VLSI ASA has two different modes of operation, direct mode and Shock Burst mode. Shock Burs the whole idea with the Shock Burst technology is to put as much low level protocol handling into the nRF chip as possible without removing any flexibility from the user. The operation can be best understood considering two modes transmitter and receiver mode as follows. In the transmitter mode, the micro-controller decides that it will transmit a packet via the Zigbee device, and pulls the Chip Enable signal high. Then the micro-controller clocks its packet into the Data out Register, using the Clock and Data pin on the Zigbee. The packet contains receivers address and the payload If CRC is enabled, the SBE will calculate the CRC of the data that is being transmitted. Transmission of the packet will start 202us after the Chip Enable signal has been pulled low by the micro-controller. In the receiver mode, the external low cost micro-controller will before operation configure the Zigbee. During this configuration the Zigbee will be told what is its own address, what packet length it shall receive, what bit rate (250kbit/s or 1Mbit/s) it shall use on air and if it shall perform CRC or not. In this case we assume that own address is N bits wide,If the bits match the CRC calculator will calculate the checksum of the whole Packet and compare if the result is equal to the CRC bits in the received packet. If the CRC does not match, the SBE will continue to compare incoming bits with own address until a new match is found, and then repeat the CRC calculation. After configuration of the Zigbee, the low cost micro-controller can go into hibernation.

5. Conclusion and Future Work

The proposed system requires low power and less cost, anal it doesn't need GPS or GSM to locate distance of the bus. By the RSSI based distance calculation we can able to find the exact distance of the bus arrival. Since WSN can address 16-bit addressing, more number of vehicles can identify without any
data collision and network problem. The vehicle is enabled with an on-board unit that contains the unique vehicle id (Zigbee MAC id) and information. The development of transport information system using the ZigBee transceiver to know about the bus arrival information was successfully tested by interfacing ZigBee transceivers with ARM LPC2148 and PIC 16F877A. The future work of this project is to develop centralized database of the bus status information and to create accessibility using an android mobile with the help of internet access.

Fig 4 ARM INTERFACING WITH ZIGBEE (BUS TERMINOUS)

Fig 5 PIC INTERFACING WITH ZIGBEE (BUS)

Fig 6 INITIAL STATE (BUS TERMINOUS)

Fig 7 INITIAL STATE (BUS)

REFERENCES


